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1. Added Flat Face Machining Control 
Function to Contour Projection 

A function to control the machining of flat faces has been added to Projection settings of 
Contour Projection. 
This function prevents tool path for Projection from being output to flat faces to avoid 
machining the flat faces when tilt areas are machined with Projection. 
Flat faces are used when it is more efficient to process the flat faces separately by Flat 
Face Machining. 
 

 Setting Screen 
 
Contour Projection Machining - Set Screen 
 
Select the function to control flat face machining from [Advance] of [Contour Projection Machining]. 
When [Machining Mode] is set to [Contour Projection] or [Projection], settings are made in 
the [Projection Machining] setting screen. 
When the [Control Flat Surface Machining] checkbox is checked in [Detail Parameter] of 
the [Projection Machining] setting screen, the Control Flat Surface Machining is applied. 
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Examples of Path Outputs 

 

 
 
 

 Supplementary Note 
 
Even when [Machining Mode] is set to [Contour Projection] and [Control Flat Surface 
Machining] is selected, [Horizontal Surface Detection] in [Finish Allowance/Accuracy 
Setting] can also be set. 

 

  

When Control Flat Face 
Machining is not used 

When Control Flat Face 
Machining is used 
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2. Added the Stock File Name Automatic 
Update Function to [Stock Model Input] 

A function has been added to automatically update the stock file name set in [Stock Model 
Input] when the machining name of the machining data to be imported is changed. 
In the previous version of FFCAM, when the machining name of the machining data to be 
imported changed, it was necessary to update the corresponding stock file names one by 
one manually. 
In FFCAM 2022, since stock file names are automatically updated, the stock file names 
need not be updated manually and errors due to missing the updates can be avoided. 
 

 Operation Screen 

 

Machining Data to Set [Stock Model Input] 

In [Stock] of [Uncut Model Setting], select the checkbox of the [Stock Model Input].  
Specify the machining name of the machining data to be imported from the "Select 
from set data" pull-down list. (Similar to the previous procedure) 

* The function to update the name automatically cannot be used when the 
machining name is specified by "Select from Created Data" or "Select from file". 
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* Change of name by the following are covered by the automatic update function. 
 
 Change the machining name (including changes by the auto-numbering 

function) 
 Change the process name (including changes by copying the process) 

Machining data to be imported 
Change the machining name of the machining data to be imported.  

Click . 

Machining data with [Stock Model Input] set 

The [CL] status of the machining data with [Stock Model Input] set in the 
[Machining Data Selection] window will also change to yellow. 
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 Note 
 

The following are not covered by the automatic update function for stock file name. 
 

 When machining data is copied within the same process 
 When machining data is copied from different processes 
 When copying machining data from other work data (xMtn file) 
 When changing the process name and machining name by using macros 

 
  

When the machining data with [Stock Model Input] set is opened, the stock file 
name is automatically updated. 
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3. Added a Function to Copy the Machining 
Range Set in the [Machining Area] to the 
[Non-machining Area] 

The area set in [Machining Area] or [Non-machining Area] of each machining can now be 
used by copying to [Machining Area] or [Non-machining Area] of other machining. 
 
* The area that is set in the [Non-machining Area] of other machining can be copied to the 

[Machining Area]. 
Similarly, the area that is set in the [Machining Area] of other machining can be copied to the 
[Non-machining Area]. 

 

Copy the area using the  button displayed in [Area Type] of [Machining Area] or [Non-
machining Area] in the area setting screen of each machining. 
 
* Only copy areas of machining for which the [Area Type] is set to [Curve] or [Curved 

surface] in the same process can be copied. 
 

 Operation Screen 
 
1. On clicking the  button displayed in [Area Type] of [Machining Area] or [Non-

machining Area], the [Select Area] window is displayed. 

 

* The  button is enabled only when [Area Type] is set to [Curve] or [Curved surface]. 

  

Machining Area Non-machining Area 
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2. Select the machining to copy the area from the machining names listed in the [Select Area] 
window. Click [OK] to copy the areas of the selected machining. 

 

 
 

 Select Area screen 
 
Machining Area (tab) 
For machining of the same process, the name of the machining with area set in [Machining 
Area] is displayed in the list. 
 
Non-machining Area (tab) 
For machining of the same process, the name of the machining with area set in [Non-
machining Area] is displayed in the list. 
 
List 
If [Curve] is selected as [Area Type], the name of the machining with the [Curve] area is 
displayed, and if [Curved surface] is selected as [Area Type], the name of the machining 
with the [Curved surface] area is displayed. 
 
OK 
Copies the areas of the machining selected in the "List". 
In this case, the specified value for [Tool Radius Inside] or [Tool Radius Outside] in [Area 
Offset] is calculated and applied from the tool diameter of the machining from which the 
area is copied. 
 
Cancel 
Cancels the operation and closes the [Select Area] window. 
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 Example of operation screen (when the machining from which the 
area is copied is selected) 

 

 

Copy a curved area 
 
The curved area set in the selected machining is highlighted and the guide lines are 

 

Copy a curved surface area 
 
The curved surface area set in the selected machining is highlighted. 
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4. [Machine Parameters] Improvement to 
Enable Setting the NC File Extension for 
Each Machine 

The NC file extension to be output can now be set for each machine. 
Along with this change, the setting options of [NC File Extender] in machine parameters 
have been moved from [NC Output Parameter] to [FFPOST PARAMETER] of each 
machine. 
 

 Setting Screen 
 
The [NC File Extender] can be set in the [FFPOST PARAMETER] -> [FFPOST] tab of each 
machine. 

 

* The [Output Filename Setting] tab in [NC Output Parameter] in which the [NC File 
Extender] was previously set has been removed. 

  

Machine Parameters [FFPOST] screen 
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The NC file extension set for each machine are referenced by the Machining Data Setting 
screen in the following cases. 
Opens the NC file with the extension set for the machine displayed in the machine name 
when the  ([Open the NC File]) button is clicked. 

 

  

Machining Create screen 

Repost - Information screen 
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5. [Machine Parameters] Improvement to 
Enable the Setting of [Safety mode at 
hole ATC] for Each Machine 

The [Safety mode at hole ATC] can now be set for each machine. 
Along with this change, the setting options of [Safety mode at hole ATC] in the machine 
parameters have been moved from [NC Output Parameter] to [MACHINE PARAMETER] 
for each machine. 
 

 Setting Screen 
 
The [Safety mode at hole ATC] can be set in the [MACHINE PARAMETER] -> [ATC] tab of 
each machine. 

 

* The options of [Safety mode at hole ATC] in [NC Output Parameter] -> [Path Parameter 
Setting], which was used to set the [Safety mode at hole ATC], has been removed. 

  

Machine Parameters [ATC] screen 
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6. [Machine Parameters] Added New 
Models to the Machine List 

New models have been added to the machine list of Machine Parameters. 
 

 Setting Screen 
 
New models have been added to each part of the Machine Parameters. 

 

(1) Parameter name - MACHINE tree 
The following models have been added. 
iQ500, V100S, v61, a71nx, a92, a120nx 
 
The addition of the models are also reflected in the model name selection of the 
process data. 

 

Machine Parameters screen 

(1) 
(2) 

Machining Data Selection screen 
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(2) High accuracy time prediction - Machine Parameters file 
The following models have been added. 
a40, a500Z, D200Z, DA300, iQ500, V80S, V90S, V100S, D800Z, v61, a92, a71nx, 
a120nx, N2-5XA 

 

 Note 
 
 The following models have been deleted from "Parameter name - MACHINE tree".  

MCC1513, MCC2013 
However, if you have used the Data Migration Tool to migrate the machine parameter 
files of FFCAM2021 or earlier, the machine parameter files of MCC1513 and 
MCC2013 will also be restored. 
 

 For the following models, the default value of [High accuracy time prediction] has been 
changed to [Yes]. 
V22, V33i, V56i, V77, V99, iQ300, iQ500, v61, N2, a40, a51nx, a61nx, a71nx, a81nx, 
a92, a120nx, a500Z, N2-5XA, V22-5XB, V33i-5XB, D300, DA300, D500, D200Z, 
D800Z, V80S, V90S, V100S 
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7. Added a Macro to Acquire the Stock Min. 
Detect Width 

A macro to acquire the stock Min. Detect Width for the pre-machining information has been 
added to [Custom macro edit]. 
The following macro has been added. 
 

Tab Variable name Explanation Remarks 

Machining MCdeleteGapWidth 
Min. 
Detect 
Width 

Data type: Real data 
Stock min. detect width is acquired. 

 

 Setting Screen 
 
Custom macro edit screen 

 

Macro edit screen 
 
Example: Set the Min. Detect Width of the Stock to the value obtained by subtracting "0.01" 
from the stock Min. Detect Width of pre-machining. 

"pre_mMCdeleteGapWidth-0.01" 
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8. Improvement to Enable Checking the 
Machining Time in the List of the 
Machining Data Selection Screen 

Now the Machining Time can be checked from the list of the Machining Data Selection 
screen. 
Users had to check the Machining Time in the output information file in the previous 
FFCAM versions. 
The Machining Time can now be easily checked on the screen in FFCAM 2022. 
 

 Explanation of Screen 
 
A column has been added to display the Machining Time (hh:mm:ss) in the list of the 
Machining Data Selection screen. 

 

 Note 
 

The Machining Time is displayed after path calculation is completed successfully. 

 

  

Machining Data Selection screen 

3D machining data 

Drilling data 
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9. Added Options to Show/Hide All CL 
Paths in the Right-click Menu of the 
Machining Data Selection Screen 

Options have been added to the right-click menu of the Machining Data Selection screen to 
show or hide all CL paths for each process or machining. 
An option was available to hide all CL paths in previous FFCAM versions, but an option to 
show or hide CL paths by process or machining was not available. 
CL paths can be shown or hidden by process or by machining in FFCAM 2022. 
 

 Operation Screen 
 
Options "Full display of machining CL in process/All machining CL in the process is hidden 
" and "Display of machining CL in process/Hide machining CL" have been added to the 
right-click menu of the process or machining list in the Machining Data Selection screen. 
 

Screen Example: Right-click menu of the 3D machining/Process list 

 

  

Right-click 
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Full display of machining CL in process/Display of machining CL in 
process 
Displays all CL paths in the selected process or machining. 
 

All machining CL in the process is hidden /Hide machining CL 
Hides all CL paths in the selected process or machining. 

  

Right-click menu of the 3D 
machining/Machining list 

Right-click menu of the 
Hole Process list 

Right-click menu of the 
Drilling list 
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10. Improved the Display of the 
Confirmation Dialog when Starting 
Path Calculation 

A function has been added to set whether to display a confirmation dialog when the [Path 
Calculation] button is clicked to start the path calculation. 
Use this function to avoid the display of the confirmation dialog that delays the operation 
when a path calculation is started. 
 

 Setting Screen 
 
Confirmation Dialog 
A check box that allow users to select "Do not show this again." has been added to the 
confirmation dialog that is displayed when the [Path Calculation] button is clicked. 

 

If you select the "Do not show this again." check box and select [Yes] to perform the path 
calculation, the confirmation dialog is not displayed from the next time onwards. 
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Option Set Screen 
In the [Advanced Setting] window of the [Option Set Screen], users can set in advance 
whether to display the confirmation dialog. 

 

If the option is set by removing the check from the "Displaying the confirmation when 
starting the Calculate tool path" check box, the confirmation dialog is not displayed from the 
next time onwards.  
* By default, the check box is selected. 
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11. Improved the Display of the 
Confirmation Dialog when Copying 
Machining Data with the Machining 
Area Set 

A function has been added that can be used to set whether to display a confirmation dialog 
when copying the machining data, for which the machining area is set, to the [Machining 
Data Selection] window from the template. 
Use this function to avoid the display of multiple confirmation dialogs that delays the 
operation when machining data with machining area already set is copied several times. 
 

 Setting Screen 
 
Confirmation Dialog 
A check box allowing the user to select "Do not show this again." has been added to the 
confirmation dialog, which is displayed when machining data with a machining area already 
set is copied from a template to the Machining Data Set window. 

 

If you select the "Do not show this again." check box and select [Yes] to perform the copy 
operation, the confirmation dialog is not displayed from the next time onwards.  
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Option Set Screen 
In the [Advanced Setting] window of the [Option Set Screen], users can set in advance 
whether to display the confirmation dialog. 

 

If the option is set by removing the check from the "When copying from the template, the 
confirmation of the machining area setting copy is displayed." check box, the confirmation 
dialog is not displayed from the next time onwards.  
* By default, the check box is selected. 
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12. Added a Measurement Result Type to 
[Maximum and Minimum on Geometry] 
of Measurement 

A function has been added to display "Length" in the measurement results of [Maximum 
and Minimum on Geometry] (Measurement type: Box) of [Measurement]. 
After measurement, the length of the X, Y, and Z sides are displayed along with the 
maximum and minimum values of X, Y, and Z of the box that used to be displayed in 
previous versions of FFCAM. 
 

 Operation Screen 
 
Lengths of the X, Y, and Z sides of the box are displayed after measuring with [Maximum 
and Minimum on Geometry] (Measurement type: Box). 

  

 

Measurement [Maximum and Minimum on Geometry] screen 
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13. Added a Function to set RGB Color with 
1/256 Code to the Color Filter of Element 
Selection Screen 

A function to specify the color of the color palette using RGB colors with 1/256 code has 
been added to the color filter of the element selection screen. 
In addition to the previous method of specifying colors with 256 gray levels, it is now 
possible to specify colors in 1/256 code. 
 

 Setting Screen 
 
Radio buttons to select "256 gray levels" or "1/256 code" have been added to the RGB 
color input field of the color palette on the element selection screen. 

 

Option Settings [Selection Filter] window 

Color palette of [Color] Set on the element selection screen 
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256 (default value) 
Enter the RGB color setting values with 256 gray levels as before. 
Enter an integer value between 0 and 255. 
 
0.0-1.0 
Enter the RGB color setting values with 1/256 code. 
Enter a real number between 0.0000000 and 1.0000000 (up to 7 decimal places). 
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14. Improved Work Origin Setting Function 
on Repost - Information Screen 

In the previous versions of FFCAM, after setting the work origin on the Repost - Information 
screen, the work origin was reset when switching to the Machining Create screen and then 
back to the Repost - Information screen. 
In FFCAM 2022, this function has been improved so that the work origin which is set on the 
Repost - Information screen is retained on the Repost - Information screen even after 
switching to the Machining Create screen. 
 

 Explanation of Screen 
 
The work origin set on the Repost - Information screen is retained on the Repost - 
Information screen even after switching to the Machining Create screen. 

 

  

Repost - Information screen 
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15. Enhanced Help Menu 
The Help menu has been enhanced.  
In addition to the previous help reference, FFCAM related documentation, FAQ, 
troubleshooting, tool manufacturer's database, etc. can now be accessed directly from the 
Help menu. 
 

 Operation Screen 
 
Multiple menus have been added to the Help menu. 

 

(1) Help Documentation 
Opens the same help file as before. 
 

(2) FFCAM Home 
Opens the FFCAM website in the web browser. 
* Connects to the Makino website over the Internet. 
 

(3) New Functions Manual / Release Note 
Opens a page to browse (download) the new functions manual and release notes in 
the web browser. 
* Connects to the Makino website over the Internet. 
 

(4) Tool Database Download 
Opens a page in the web browser to browse (download) the tool manufacturer's 
database. 
* Connects to the Makino website over the Internet. 
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(5) FAQ/Troubleshooting 
Opens a page in the web browser to browse (download) FAQ and troubleshooting 
information. 
* Connects to the Makino website over the Internet. 
 

(6) Training Manual 
Opens a page in the web browser to browse (download) the training manual. 
* Connects to the Makino website over the Internet. 
 

(7) Version Information 
Displays the FFCAM version information as in the previous versions. 

 

 Note 
 

The options for connecting to the Makino website over the Internet can be accessed 
when the FFCAM is launched on a PC that is connected to the Internet. 
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16. Added the Function to Set Random 
Colors for Rest Model Color and Corner 
R Color 

A function to set random colors automatically has been added to the color setting screen for 
[Rest model color set] of [Simulation] and [Corner R] of [Measurement]. 
Set using the pull-down menu of the [Auto Setting] button of the setting color. 
 

 Setting Screen 
 
When auto setting the setting color, select [Gradient color] or [Random color] from the pull-
down menu of the [Auto Setting] button. 
 
Rest model color set screen                  Corner R Color screen 

 

Gradient color 
Sets the setting colors of lines without check marks with a gradient color (gradation). 
* This is the setting method used in the previous version of FFCAM. 
 
Random color 
Sets the setting colors of lines without check marks with a random color. 
* This is the setting method used in FFCAM 2022. 
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Example: Random color 
 
Remove the check mark from the line for which you want to change the setting color, open 
[Auto Setting] pull-down menu, and select [Random color]. 
The setting colors of the lines for which the check mark has been removed are set 
randomly. 
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17. Improved Animation Playback Speed 
Setting Function of Simulation 

In the Extend (3-5Axis) simulation, the playback speed setting for Cutting Animation in the 
[Create Data (Details)] menu has been increased to 9 levels. 
Previous versions of FFCAM had speed settings up to 7 levels. The animation playback 
speed can now be adjusted more precisely in FFCAM 2022. 
 

 Setting Screen 
 
Extend (3-5Axis) Simulation screen 
 
When executing [Create Data (Details)], use the slider bar in [Cutting Animation] to set the 
animation playback speed. 

 

 
The slider bar allows the speed to be set in the following 9 levels: 
 

Scale Display speed  
0: Slow 1 second drawing per block  
1 0.1 second drawing per block  
2: Normal Drawing per block  
3 Drawing per 20 blocks ※ Added in FFCAM 2022 
4 Drawing per 50 blocks ※ Added in FFCAM 2022 
5 Drawing per 100 blocks  
6 Drawing per 1000 blocks  
7 Drawing per 5000 blocks  
8: Fast Drawing per 10000 blocks  
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18. Added a Function to Copy FFCAM Work 
Data Automatically 

The [Copy of saved data] function has been added to temporarily save a copy of the work 
data in case the work file is corrupted, such as when FFCAM is unintentionally terminated. 
When the [Copy of saved data] function is used, a copy of the work data is saved at regular 
intervals when performing operations, so that the work data can be restored from the 
copied data in case the work data is corrupted. 
You can set whether to use the [Copy of saved data] function, and the interval for automatic 
copy, etc. 
 

 Setting Screen 
 
It is possible to set whether to use the [Copy of saved data] function, and the interval of 
automatic copy in [File Related] of the [Option Set Screen]. 

 

Copying the saved data 
Specify whether to use the [Copy of saved data] function. 
The default value is "Use" (check is ON). 
 
Copy interval of saved data (min… 
Specify the interval in minutes to copy the data automatically. 
The initial value is "30 minutes". Interval between 1 and 120 minutes can be specified. 
 

 

 

Option Set Screen 
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 Notes on copied data 
 
The [Copy of saved data] function automatically saves a copy of the work data at set time 
intervals while you are working in FFCAM.  
* The data in the working state is not copied and saved.  

The last saved data is copied for each time period that is set. This function is different 
from a backup. 

 
 Since the copied data is saved as a specific file separate from the work data, a restore 

operation (see below) is required to restore the work data. 
 
 The copied data is saved in a specific folder (FFCAM 2022 installation 

folder¥Backup¥AutoBackup). 
 
 The copied data is overwritten and saved at set time intervals, starting from the time 

when FFCAM is started.  
* Data copied every hour will not be retained. 

 
 When the work screen (when closing the xMtn file) ends, the copied data is 

automatically deleted if the work screen ends normally.  
The copied data is retained only when the work screen is closed abnormally. 

 

 Restore the copied data 
 
When FFCAM is started, the [Copy of saved data] screen is displayed on the FFCAM 
screen if copied data exists (that is, if FFCAM did not end normally in the previous 
operation and copied data has been retained). 
When the work data is required to be restored, you can do so from the [Copy of saved data] 
window. 

 

Copy of saved data window 
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Project Name 
Displays the name of the original xMtn file. 
 
Project Folder 
Displays the path to the folder where the original xMtn file is saved. 
 
Date and Time 
Displays the update date and time of the original xMtn file (the last saved date and time 
when the file was copied). 
 
Restore (button) 
Use this button to restore the work data. 
When you click on the button, the window to specify the file name and save (restore) folder 
is displayed. 

 

The target copy data is saved (restored) as work data.  
You can overwrite the original xMtn file (if the original file is closed) or save the copy data 
with a different name to any location. 
The xMtn files saved here can be used as the working files. 
 
Open Folder (button) 
Opens the folder containing the target copied data. 
 
Delete (button) 
Deletes the target copied data. 
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 Display the [Copy of saved data] window from the menu 
 
You can optionally open the [Copy of saved data] window while working in FFCAM. 
From [Tool] menu or [Window] menu, select [Copy of saved data]. 

 

* The [Copy of saved data] window is displayed when copied data has been saved.  
The same operations as in "Restore the copied data" (described above) can be performed 
in the [Copy of saved data] window that is displayed. 

 

 Supplementary Note 
 
 The "xMtn file", "mmtn file", and "Config folder" are saved as copied data. If the "smtn 

file" exists, it is also be saved.  
Each set of files is restored during restoration. 

 
 The work data opened in FFCAM is automatically copied.  

If multiple work data are open, all the files are duplicated and saved at the same timing 
(starting from the time when FFCAM is launched, at the interval set for automatic 
copy). 

 
 The measurement result data is not be copied. 
 
  

[Tool] [Window] -> [Show/Hide Resource Windows] 
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19. Expanded Types of Data that can be 
Migrated with the Data Migration Tool 

In the Data migration tool of previous FFCAM, only specific data could be migrated and 
files such as Machining Instruction Sheet, templates, and insert statement texts could not 
be migrated. 
In FFCAM 2022, the Data migration tool can now backup and restore files such as Machining 
Instruction Sheet, templates, and insert statement texts with settings by the user. 
* Only applicable for files saved in the "Data" folder of the FFCAM installation folder. 
* Only applicable for data that has been backed up in FFCAM 2022. 
 
In the FFCAM 2022 setting file, the following files saved in the "Data" folder (distributed 
only to specific customers) are initially set to be migrated. 
 Infomation.xsl 
 CheckHolderName.xsl 
 get*.xsl (files with the extension ".xsl" starting with get) 
 Get*.xsl (files with the extension ".xsl" starting with Get) 

 
for migration of other files, the file names must be written in the setting file. 
For the procedure, refer to the FAQ on the FFCAM support site. 
 

 Setting Screen 
 
The [Data migration tool] also migrates the file information described in the setting file. 
* The operation screen and the operation method are the same as previous FFCAM 

versions. 
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20. Improved Setting Screen of 
[Simultaneous 5-Axis Machining] for  
[2 points] Control of Tool Axis  
[Relative to axis] 

When specifying [5-Axis Simultaneous Movement] -> [Control of tool axis] -> Control 
method [Relative to axis] -> Reference axis [2 points], the coordinate values of the 2 points 
specified by picking are now displayed. 
This allows users to quickly check the coordinate values of the specified 2 points. 
 

 Setting Screen 
 
Picking 2 points when Control method [Relative to axis] -> Reference axis [2 points] is 
specified, will display the coordinate values of the 2 points in a table format. 

 

The X, Y, and Z coordinate values of the first point are displayed in the first line of the table, 
and the X, Y, and Z coordinate values of the second point are displayed in the second line 
of the table, allowing users to check the values. 
Users can also select a cell of each coordinate value and make changes by entering the 
value. 
When the coordinate values are changed, the vector and tool drawing in the graphics 
window are also updated. 
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21. [Machine Simulator Option] Now 
Supports M56 

The Machine Simulator Option now supports M56 (Tool Offset Transfer Command). 
 

 Explanation screen 
 
When M56 is detected by the NC process, the tool offset value is set appropriately to 
reproduce the behavior of M56. 
This function is enabled when [Use Tool offset screen value] is specified in [Initial setting] -> 
[Program] -> [Tool offset amount]. 

 

 


	1. Added Flat Face Machining Control Function to Contour Projection
	2. Added the Stock File Name Automatic Update Function to [Stock Model Input]
	3. Added a Function to Copy the Machining Range Set in the [Machining Area] to the [Non-machining Area]
	4. [Machine Parameters] Improvement to Enable Setting the NC File Extension for Each Machine
	5. [Machine Parameters] Improvement to Enable the Setting of [Safety mode at hole ATC] for Each Machine
	6. [Machine Parameters] Added New Models to the Machine List
	7. Added a Macro to Acquire the Stock Min. Detect Width
	8. Improvement to Enable Checking the Machining Time in the List of the Machining Data Selection Screen
	9. Added Options to Show/Hide All CL Paths in the Right-click Menu of the Machining Data Selection Screen
	10. Improved the Display of the Confirmation Dialog when Starting Path Calculation
	11. Improved the Display of the Confirmation Dialog when Copying Machining Data with the Machining Area Set
	12. Added a Measurement Result Type to [Maximum and Minimum on Geometry] of Measurement
	13. Added a Function to set RGB Color with 1/256 Code to the Color Filter of Element Selection Screen
	14. Improved Work Origin Setting Function on Repost - Information Screen
	15. Enhanced Help Menu
	16. Added the Function to Set Random Colors for Rest Model Color and Corner R Color
	17. Improved Animation Playback Speed Setting Function of Simulation
	18. Added a Function to Copy FFCAM Work Data Automatically
	19. Expanded Types of Data that can be Migrated with the Data Migration Tool
	20. Improved Setting Screen of [Simultaneous 5-Axis Machining] for  [2 points] Control of Tool Axis  [Relative to axis]
	21. [Machine Simulator Option] Now Supports M56

